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Lightroom is an image management and editing program designed especially 
for photographers. It guides you through your workflow, including organizing, 
editing, and sharing your digital images and videos.

It’s designed around a database, rather than a file browser, so it keeps a record of the files even 
when the original photos are offline. That also makes it quick to search and find photos.

Lightroom’s Develop module is a non-destructive, parametric editor. That simply means that your 
edits are saved as text instructions, rather than being applied to the pixels themselves, so it doesn’t 
degrade the original image data. You can experiment without fear.

This Quick Start Guide is designed to guide you through a simple Lightroom workflow. It’ll give you 
a taste of what Lightroom can do, and help you to feel comfortable using Lightroom to manage 
your photos, while avoiding the most frequent problems.

We’re not going to cover every tool, button, slider and checkbox, and we’re not going to cover all 
the possible variations in workflow. If we did, it would fill hundreds of pages and then it wouldn’t be 
a getting started guide!

You’ll find detailed information in the Help documentation provided by Adobe at 
http://helpx.adobe.com/lightroom.html and in books such as my own book, Adobe Photoshop 
Lightroom 5 - The Missing FAQ, available from http://www.lightroomqueen.com and online 
bookstores. I hope you find the information useful. Now let’s get started...

INTRODUCTION

WHAT IS A CATALOG?

All of the information about your photos 
is stored as text in a database. This is 
called a Lightroom Catalog. In a library 
of books, the library catalog doesn’t 
contain the books themselves, but 
a record of where to find each book 
and information about it. Similarly, 
Lightroom’s catalog records where to 
find the photo on the hard drive and 
stores information about that photo, 
but it doesn’t contain the photo itself. 
Lightroom also keeps small previews 
of the photos, like a library catalog may 
keep a photo of the book’s cover.

http://www.lightroomqueen.com/lr5quickstart
http://helpx.adobe.com/lightroom.html
http://www.lightroomqueen.com/
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Before you start importing your photos into Lightroom, you have a couple 
of decisions to make. Making them now will save a lot of unnecessary 
work later.

First, you need to decide where to store your catalog and photos on your computer. And then it’s 
useful, but not essential, to decide on your folder structure and file naming. In a recent poll, folder 
structure was the main thing Lightroom users wished they’d understood when they started.

WHERE WILL YOU STORE YOUR CATALOG?
Because Lightroom is a non-destructive editor and cataloging program, all of the information about 
your photos and the changes you’ve made within Lightroom are stored in Lightroom’s catalog.

When you first start Lightroom, it’ll ask you where to store the catalog and what to name it. By 
default, the catalog will be called Lightroom 5 Catalog.lrcat and it will be stored in your main 
Pictures folder. 

Next to the catalog, Lightroom will create a Previews folder (Windows) / file (Mac) called Lightroom 
5 Catalog Previews.lrdata. The previews folder/file contains a small JPEG preview of all the photos 
you import, so it can grow very large.

We’ll select the location in the “Installing Lightroom” section on page 10.

BEFORE YOU START

DO I HAVE TO USE A CATALOG?

Lightroom always creates a catalog, but 
you can add the files at their existing 
location, so it doesn’t have to turn your 
existing workflow upside-down. It’s also 
possible to write some of the settings 
into the files themselves, or sidecar 
files for proprietary raw files, using a 
metadata format called XMP.
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If you have plenty of space on your boot drive (usually C:\ on Windows or Macintosh HD on Mac), 
then you could keep the catalog and previews in the default location, or you could select another 
drive. If you’re not sure what to choose, Lightroom will use the default settings, and you can choose 
to move it later. 

Wherever you choose to store your catalog and previews, make a note of the catalog name and 
location you choose, as you’ll need to ensure the catalog is backed up.

WHERE WILL YOU STORE YOUR PHOTOS?
Lightroom doesn’t hide your photos away from you. They’re kept as normal image files in folders 
on your hard drive, which you can also access using other software. We’ll select the location in the 
“Getting Photos Into Lightroom” section on page 15.

By default, Lightroom will copy your photos into the Pictures folder in your user account. If you 
already have an organized filing system, you can choose to leave the photos where they are, or you 
can choose another location, such as another hard drive. 

If you work on a laptop, or a desktop computer with a small boot drive, remember that your 
Pictures folder will fill up quickly, so you may want to store your photos on another internal drive or 
a mains-powered external drive instead of the default Pictures folder.

It’s best to keep all the folders of photos under a single parent folder (or one for each drive), 
rather than scattering the photos around your hard drives. It’s easier to back up the photos if 
they’re in one or two locations. As your collection of photos grows, you can easily expand onto 
additional hard drives.

JUST ONE CATALOG?

Lightroom is designed to manage all of 
your photos in a single catalog. It can’t 
search across multiple catalogs or open 
multiple catalogs at the same time. 

Unless you have a really good reason 
for using multiple catalogs (for 
example, personal vs. work photos), 
try to stick to just one, and use folders 
and collections to separate different 
types of photography.

CATALOGS VS. FILE BROWSERS

Originally recorded using Lightroom 1, 
George Jardine’s video remains one of 
the best explanations of using catalogs 
instead of browsing for files. 
http://www.lrq.me/jardine-catalogs

http://www.lightroomqueen.com/lr5quickstart
http://www.lrq.me/jardine-catalogs
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HOW WILL YOU ORGANIZE YOUR PHOTOS INTO FOLDERS?
Importing photos into Lightroom doesn’t force you to rearrange them. If you already have a well 
thought out filing system, you can keep your existing folder structure. It’s best not to duplicate 
photos in multiple folders—we’ll explore how to use keywords and collections to group similar 
photos.

As far as Lightroom’s concerned, your choice of folder structure doesn’t make a lot of difference. 
Folders are just a place to store the photos, and you can use metadata/keywords to organize them. 
That said, you do need some level of organization to make it easy to back up your photos.
Many people choose a date-based folder structure, with folders for days (or shoots) within folders 
for months, which in turn are in folders for years.

HOW WILL YOU NAME YOUR PHOTOS?
The main things to consider when naming your files is to make the names unique. File names 
direct from the camera may be repeated many times. For example, if your camera creates names 
like IMG_4857, once you’ve taken 9999 photos, it will start counting again at 0001. If a file 
doesn’t have a unique name, and it’s accidentally moved to another folder, other photos could be 
overwritten.

The date and time works well as a unique file name, for example, YYYYMMDD-HHMMSS (year 
month day—hour minute second). If you prefer to keep to the camera file name, YYYYMMDD-
original file number (and a camera code if you’re shooting with more than one camera) can work 
well with a low risk of duplication.

You can rename the files at any time, as long as you do it within Lightroom, but doing it at the 
time of import means that any backups you make while importing will have the same names as the 
working files.

WHAT IS METADATA?

Metadata is often defined as ‘data 
describing data’.

As far as photos are concerned, 
metadata describes how the photo 
was taken (camera, shutter speed, 
aperture, lens, etc.), who took the 
photo (copyright) and descriptive 
data about the content of the photo 
(keywords, captions).

Lightroom also stores all of your 
Develop edits as metadata, which 
means that it records your changes as 
a set of text instructions (i.e. Exposure 
+0.33, Highlights −30, Shadows +25, 
etc.) instead of applying them directly 
to the image data. That means you 
can change your mind later without 
degrading the image.
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We mentioned earlier that Lightroom guides you through a basic 
workflow, and we’re going to follow its lead in this eBook. Here’s a 
quick summary of the path you’ll take...

Capture  • Think about your file format—raw vs. JPEG
 • Expose the photo correctly in the camera to produce the best quality

Import  • Store photos in organized folders
 • Consider renaming to a unique filename
 • Apply basic metadata such as copyright and general keywords
 • Apply any Develop presets as a starting point, such as a camera profile
 • Build previews to save time later

Organize  • Browse through your photos
 • Manage photos in folders
 • Group photos into collections and stacks
 • Add flags, star ratings and labels to identify your favorite photos
 • Add additional metadata, such as keywords and map locations
 • Search for photos using filters and smart collections
 • Don’t forget to back up the catalog as well as the photos themselves

BASIC LIGHTROOM WORKFLOW

http://www.lightroomqueen.com/lr5quickstart
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Develop 
& Retouch

 • Adjust tone & color
 • Remove noise, sensor dust, sharpen and apply lens corrections
 • Straighten & crop
 • Apply effects, such as black & white or split tones
 • Switch to Photoshop and other external editors for pixel based editing
 • You can also create panoramic shots and HDR photos in external editors

Output  • Create finished files in the size, format and color space of your choice
 • Email your photos direct from Lightroom
 • Print using your printer or save layouts to JPEG to print at a local print lab

There are further output options which we won’t consider in this Quick Start 
Guide, including:

 • Use Export plug-ins to enhance your export, such as adding borders
 • Design photo books, save them as PDF eBooks or have them printed by Blurb
 • View slideshows and export them to video, PDF and JPEG formats
 • Create web galleries to upload to your website
 • Use Publish Services to synchronize with Flickr and other photo sharing 

websites or folders on your hard drive
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Whether you’re installing the trial for the first time, or you’ve 
already purchased Lightroom, the installation and program 
are the same.

Download the latest version from Adobe—it’s always the full program, so you can just download the 
trial from https://www.adobe.com/go/trylightroom/

MINIMUM SYSTEM REQUIREMENTS
The minimum system requirements for installing Lightroom are:

Windows
 • Intel® Pentium® 4 or AMD Athlon® 64 processor
 • DirectX 10–capable or later graphics card
 • Microsoft® Windows 7 with Service Pack 1 or Windows 8
 • 2GB of RAM (4GB minimum recommended)
 • 2GB of available hard-disk space
 • 1024x768 display
 • Internet connection required for Internet-based services

INSTALLING LIGHTROOM

http://www.lightroomqueen.com/lr5quickstart
https://www.adobe.com/go/trylightroom/
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Mac
 • Multicore Intel® processor with 64-bit support (that’s all Intel Macs apart from 

the original Core Duo)
 • Mac OS X 10.7 (Lion) or 10.8 (Mountain Lion)
 • 2GB of RAM (4GB minimum recommended)
 • 2GB of available hard-disk space
 • 1024x768 display
 • Internet connection required for Internet-based services

That is the minimum required in order to install Lightroom, but it is likely to ‘walk’ rather than run 
on those specs! Lightroom does benefit from higher specification hardware.

MULTIPLE COMPUTERS

Lightroom’s license agreement is cross-platform (both Windows and Mac) 
and it allows the main user to use Lightroom on 2 computers as long as 
they’re not in use at the same time, for example, a desktop and a laptop.

Lightroom isn’t designed to be used over a network. The Lightroom 
catalog needs to be stored on a locally attached drive (internal or 
external), and can only be used by one person at a time. The photos, 
however, can be stored on a network drive or NAS unit.

There are options for using your catalog on multiple machines, such as 
between your desktop and laptop. 

Those options include:

 • Export as Catalog and Import from Another Catalog to split/
merge smaller chunks of the catalog.

 • Store your main catalog and photos on an external drive, and 
plug that drive into your chosen machine.

 • Copy the catalog between devices, perhaps using software 
such as Dropbox, as long as you only use one copy of the 
catalog at a time and allow the software to finish synchronziing 
before switching machines.
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INSTALLING LIGHTROOM ON A WINDOWS PC
The Windows version comes with a standard installer, and is installed like all other Windows software.

1. Find the .exe file that you’ve downloaded and double click to run it. By default, the download 
will be stored in your Downloads folder.

2. Double click the Lightroom_5_11.exe file to start the installer. The name of the file may vary 
slightly depending on the language version.

3. Follow the on screen instructions, and agree to the License Agreement.

4. Confirm that you want to install to the main Program Files folder and then on the final screen, 
press Install. Once it’s completed, press Finish to close the installer. 

5. Go to the desktop and look for the Lightroom 5 shortcut. Double click to open the application.

 Figure 2  Extract the files to your computer before 
letting the installer automatically run.

 Figure 1  Double click on the exe 
file to start the installer.

Figure 3  Follow the on screen instructions to 
finish installing the software.

Figure 4  Double click the shortcut on 
the desktop to launch Lightroom.

http://www.lightroomqueen.com/lr5quickstart
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INSTALLING LIGHTROOM ON YOUR MAC
To install the Mac version of Lightroom you must run the installer, 
instead of dragging an app into the Applications folder.

1. Find the .dmg file that you’ve downloaded and double click to open it. 
By default, the download will be stored in your Downloads folder.

2. Double click the Adobe Photoshop Lightroom.pkg file to launch the installer.

3. Follow the on screen instructions, pressing Continue to move 
between screens, and agree to the License Agreement.

4. On the final screen, confirm that you want to install to the main 
Applications folder and press Install.

5. The installer will ask for your 
computer administrator password 
before installing. Once it’s completed, 
press Close to close the installer. 

6. Go to the Applications folder or Launchpad 
and look for Adobe Photoshop Lightroom 5. 
Double click to open the application.

Figure 5  Double click on the dmg file to open it.

Figure 6  Double click on the installer to run it.

Figure 7  Press Continue to move 
through the installer screens.

Figure 9   Double click on the app 
in the Applications folder to launch

Figure 8  Confirm the install location (Macintosh 
HD/Applications by default) and then press Install.
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OPENING LIGHTROOM FOR THE FIRST TIME
Once Lightroom is installed, there are very few differences between the 
Windows and Mac versions, apart from the slightly different appearance. 
We’ll carry on using the Mac version for screenshots, but where there are 
notable differences, we’ll show both.

1. If you haven’t used Lightroom before, it will ask to create a catalog, 
as we discussed on page 5. Press Continue to use the default 
location, or Choose a Different Destination to select another folder and 
catalog name.

2. Lightroom will then ask for your license key. If you’re using the trial, 
simply select the ‘I want to try’ option and press Finish. If you’ve 
already purchased a serial number, press Next and enter it on the next 
screen. It’s worth registering your software with Adobe too, as they will 
then keep a record of your serial number in case you lose it in future.

3. Lightroom’s main interface will open with some initial tips in the center 
of the screen. Those tips and related yellow highlights will give you a 
quick guided tour of Lightroom. You can press Next to view the tips, or 
you can check the ‘Turn Off Tips’ checkbox and click anywhere else on 
the screen to hide them.

Figure 12  Tips appear in the center of the screen, with 
yellow highlights.

Figure 10  When you first open Lightroom, it asks 
whether you want to run as a trial or enter your serial 
number.

Figure 11  Lightroom then asks where to store your 
new Lightroom catalog.

www.lightroomqueen.com14

http://www.lightroomqueen.com/lr5quickstart
http://www.lightroomqueen.com/
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As Lightroom is based around a database, the first thing you’ll need to do is add 
the information about your photos to Lightroom’s database. This process is 
called Importing. Don’t let that confuse you—although it’s called importing, 

the photos don’t go ‘into’ Lightroom. A better word to describe the process might be 
reference, link, or register.

Just because you’re importing photos into Lightroom doesn’t mean you’re tied in. Your photos 
are always accessible, the metadata can be written to the file in standardised formats that other 
software can understand (excluding Develop settings), and you can export the Developed photos to 
standardised formats if you ever decide to switch to other software.

While you’re importing the photos, Lightroom can copy or move the photos to a new location of 
your choice, but that’s not required—if the photos are already safely on your hard drive, Lightroom 
can reference them at their existing location.

First we’ll consider importing new photos from a memory card or camera, and then we’ll look at 
adding your existing photos too.

GETTING PHOTOS INTO LIGHTROOM

FILE FORMATS

Most camera raw file formats are
supported by Lightroom. You can
check whether your camera’s raw
files are supported by visiting
http://www.lrq.me/camerasupport
If your camera’s newly released, you
may need to wait for an update to
support your camera.

Lightroom can also import DNGs,
JPEGs, TIFFs, PSD files saved with
maximize compatibility, and PNG files.

http://www.lrq.me/camerasupport
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 Figure 13  Photos are added to Lightroom’s catalog using the Import dialog.

The first thing 
you’ll need to 
do is add the 
information 
about your 
photos to 
Lightroom’s 
database. This 
process is called 
Importing but 
a better word 
to describe the 
process might 
be reference, 
link, or register.”

http://www.lightroomqueen.com/lr5quickstart
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IMPORTING FROM A MEMORY CARD
1. Insert your memory card into the card reader or attach the camera to the computer. Card 

readers usually work more reliably with Lightroom than direct camera connections.

2. By default, the Import dialog shows automatically when inserting a memory card, but if it 
doesn’t appear, press the Import button in the lower left corner of the Lightroom workspace.

3. In the Source panel, on the left hand side of the Import dialog, click on your memory card. If 
you only have a single device attached, it may be selected automatically. 

4. Your photos will show as thumbnails in the central preview area. It’s possible to view and 
uncheck photos in the Import dialog, but it’s easier to sort through them in the Library module 
after import.

5. At the top of the Import dialog, select Copy. This will copy the photos from the memory card to 
your computer’s hard drive. Move and Add will be disabled automatically when importing from a 
memory card.

6. In the right hand panels, you decide how Lightroom should handle the photos as it imports 
them, including setting filenames and locations.

 Figure 16  Select Copy at the top of the dialog, to copy 
the photos to your hard drive.

 Figure 15  You can uncheck photos you don’t want to 
import.

 Figure 14  Select the memory card in 
the Source panel.

Your photos will show as thumbnails in 
the central preview area. It’s possible to 
view and uncheck photos in the Import 
dialog, but it’s easier to sort through 
them in the Library module after import.”
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7. In the File handling panel, set the Render Previews pop-up to Standard. Once Lightroom’s 
finished importing the photos, it will create previews to allow you to browse quickly.

8. Make sure the Don’t import suspected duplicates checkbox is checked. It’s not infallible but it 
helps avoid creating duplicates if you forget to reformat the card in the camera before shooting 
more photos.

9. Check the ‘Make a Second Copy’ option and click on the file path to choose a location on 
another hard drive. Consider it only a temporary backup, and not a replacement for a proper 
backup system. We’ll consider backups in more detail in the next section.

10. In the File Renaming panel, you can rename the photos as they’re imported. How have you 
decided to name your files? In this example, we’ll create a preset for a date/time based 
filename, but you can create a different filename template if you prefer. Check the Rename 
Photos checkbox, and then in the Template pop-up, select Edit.  
 

The Filename Template Editor dialog allows you to create a variety of file naming templates 
using tokens. In the Preset pop-up at the top,select the Date-Filename preset and then click 
in the white area below and delete the Filename token.  
 

Further down the dialog, in the Additional section, there’s a pop-up of date/time based 
tokens. Select Hour from the pop-up and press Insert. Repeat for Minute and Second. The 
tokens at the top should now read Date (YYYYMMDD)—Hour Minute Second.  
 

Finally, save it as a preset by selecting the Preset pop-up at the top of the dialog and choosing 
Save Current Settings as New Preset… and giving it a name. Press Done to close the dialog, 
and check that your new preset is selected in the File Renaming panel.

 Figure 18  If you select Edit in the File Renaming panel, 
you’ll see the Filename Template Editor. It uses tokens to 
build a filename structure of your choice. The date tokens 
are shown in the inset screenshot.

Figure 17  In the 
File Renaming panel, 
you can set a new 
file naming template, 
or you can leave it 
unchecked to retain 
the camera filename.

http://www.lightroomqueen.com/lr5quickstart
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PREVIEW SIZE

Minimal & Embedded—quick to import, 
but slow when viewing the photos

Standard—recommended default, takes 
time initially but much quicker when 
viewing the photos 

1:1—select 1:1 size if you need to zoom 
in on every photo to check focus.

11. In the Apply During Import panel, Develop Settings allows you to apply a preset to all of the 
imported photos, but leave it set to None for now.  
 

You can use the Metadata option to add your copyright to the photos at the time of import, 
so that none are missed. In the Metadata pop-up, select New and you’ll see the New 
Metadata Preset dialog. Give the preset a name such as Copyright Preset and enter your 
copyright information. Only checked fields will be saved. Press the Create button and your 
new preset will be selected in the Metadata pop-up in the Import dialog.  
 

In the Keywords section, you can add general keywords that apply to all of the photos, but 
we’ll come back to adding specific keywords in the Library module.

12. Finally you need to set the Destination for the photos. Where did you decide to keep your 
photos on page 6? Navigate to that location in the Destination panel.

 Figure 19  In the File Handling panel, 
choose your preview size and temporary 
backup location.

 Figure 20  In the Apply During Import 
panel, add your copyright metadata.
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13. How did you decide to organize your photos on page 7? The options at the top of the 
Destination dialog allow you to set the folder structure. The folders in italic preview the folder 
hierarchy that will be created by your import, so you can test different options to see what 
will happen. If you’re not sure which to select, the settings shown in the screenshots are a 
good default. 

14. That’s a lot of preferences to set every time you want to import some photos! But that’s not 
a problem, Lightroom will remember your last used settings, and you can keep additional sets 
of settings as presets. At the bottom of the Import dialog are the Import Presets. Select Save 
Current Settings as New Preset from the pop-up and give it a name such as ‘Import from 
Card’ and press Create. In future, you can select that preset from the pop-up.

15. Finally, press the Import button. The Import dialog will close and the photos will start to 
appear in the Library module. They’ll be grouped in a special collection in the Catalogs panel 
called Current Import/Previous Import, and they’ll also show up in the Folders panel.

Figure 22  Save your 
settings as a preset using 
the pop-up at the bottom 
of the dialog.

 Figure 21  Choose where to put the photos using 
the Destination panel. If you’re not sure which folder 
structure to use, YYYY/MM/DD is a good default.

Lightroom will remember your last used 
settings, and you can keep additional sets 
of settings as presets.”

http://www.lightroomqueen.com/lr5quickstart
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ADDING YOUR EXISTING PHOTOS
As a keen photographer, you likely already have a large number of photos and videos stored on your 
hard drive. Those photos can also be imported into your Lightroom catalog, either at their current 
location or at a new location.

1. Open the Import dialog by pressing the Import button or by going to File menu > Import Photos 
& Video. Your hard drives are listed in the Files section of the Source panel. Navigate to the 
folder currently holding your photos. If you find a standard Windows or Mac dialog easier to use, 
click the large button above the Source panel and choose Other Source from the menu.

2. Select the folders containing your photos. If the photos are stored under a single folder, such 
as the Existing Photos folder in figure [x], you can select that folder and check the Include 
Subfolders checkbox above. If your photos are spread around multiple folders, hold down Ctrl 
(Windows) / Cmd (Mac) while clicking on multiple folders, or hold down Shift while clicking on 
the first and last folder in a series of consecutive folders. If you have thousands of photos to 
import, it can help to break the import into smaller chunks, for example, 10,000 at a time.

3. Do you want to leave the photos where they are, or copy/move them to a new location? Make 
your choice from the options at the top of the Import dialog. Select:

 • Add—if you like your existing folder structure and want to leave the photos where they are
 • Move—to let Lightroom move the photos to a new location that you’ll set in the 

Destination panel
 • Copy—if you want to leave the original photos alone and create a copy in the location you 

choose in the Destination panel. You will need twice as much hard drive space if you 
choose this option, as you’ll be duplicating all of your photos.

4. In the File Handling panel, decide which size previews to build immediately after import. 
Lightroom will need to build standard-sized previews before you can view the photos, but you 
may want to delay that process until a more convenient time if you’re importing thousands of 

Figure 23  Select 
your folders of 
existing photos using 
the Files section of 
the Source panel.

Figure 24  To 
add your photos to 
Lightroom’s catalog 
without moving them, 
select Add at the top 
of the dialog.

EXPLORE DNG

Copy as DNG is one of the options at 
the top of the Import dialog. DNG is an 
openly documented raw file format. We 
won’t go into it in detail in this Quick 
Start Guide, but it’s a topic you might 
want to explore further. You can easily 
convert your files later in your workflow.
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existing photos. If you choose Minimal now, you can build previews later by selecting the photos 
in the Library menu and selecting Library menu > Previews > Build Standard-Sized Previews.

5. Don’t Import Suspected Duplicates is especially useful if you’re moving photos to a new 
location while importing

6. If you’ve set the import type to Add, your work is done—just press Import and allow Lightroom 
to register all of the selected photos in the catalog.

7. If you’ve chosen Move or Copy, you’ll need to choose where to put the photos. Where did you 
decide to keep your photos on page 6? Navigate to that location in the Destination panel.

8. How did you decide to organize your photos on page 7? As in the Importing New Photos 
section, you set the folder structure using the Organize pop-up. The folders in italic preview 
the folder hierarchy that will be created by your import, so you can test different options to 
see what will happen.

 • By Original Folders—moves or copies the photos to your new location, but retains the 
existing folder structure.

 • By Date—creates a dated folder structure, using the Date Format of your choice.
 • Into One Folder—places the photos in a single folder. When importing all of your existing 

photos, it’s usually best to skip this option.

9. Save your preset for next time, as in step 14 on page 20, and then press the Import 
button.

Figure 26  If you choose to move/copy your existing 
photos, Lightroom can replicate your previous folder 
structure or create a new one.

 Figure 25  If you’re importing a large number of 
photos, set Render Previews to Minimal and build 
them at a more convenient time.

http://www.lightroomqueen.com/lr5quickstart
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Before we go any further, it’s essential to know how to 
back up your work.

BACK UP YOUR CATALOG
Since all of the work you do in Lightroom is stored in your Lightroom catalog, you’ll need to ensure 
that it’s backed up regularly.

It’s a database, and while corruption is relatively rare, it is possible. By default, Lightroom prompts 
you to back up your catalog weekly. It creates a new folder using current date/time as the name of 
the folder, and copies the catalog into that new folder. It keeps all of those different versions, so 
you can ‘step back in time’ to an earlier version if some corruption occurs.

By default, Lightroom puts the backups in dated folders inside a Backups folder, which is stored 
next to your catalog. You can change that location to another drive using the Back Up Catalog 
dialog, and the frequency is set using the Catalog Settings dialog.

To change the settings, open the Catalog Settings dialog to the General tab. On Windows, Catalog 
Settings is under the Edit menu, or on Mac it’s under the Lightroom menu. Change the Backup 
Settings pop-up to ‘When Lightroom next exits’.’ 

BACKING UP LIGHTROOM

KEEP VERSIONED BACKUPS

Lightroom’s catalog is just a database 
and, while comparatively rare, 
databases can become corrupted—so 
backup the catalog regularly, and keep 
older backups for a while.
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Quit Lightroom and the Back Up Catalog dialog will appear. Press Choose to select a new location 
on another drive then press Back up. Leave ‘Test integrity’ and ‘Optimize catalog’ checked as they’re 
good general maintenance. 

Restart Lightroom and return to the Catalog Settings dialog to choose a suitable frequency for 
future backups. If you’re working on a large number of photos, you may want to back up every day, 
whereas if you only use Lightroom a few times each month, monthly may be plenty. Weekly is a 
good average.

BACK UP YOUR PHOTOS
Lightroom’s Catalog Backup is just that—a backup of your catalog. Your photos are not stored ‘in’ 
Lightroom and Lightroom’s Catalog Backup doesn’t back up the photos. Consider how you’re going 
to keep your photos backed up—and how easily you could restore them if there was a problem.

The ‘Second Copy’ backup in the Import dialog simply copies the imported photos into folders called 
‘Imported on [date]’ so it’s great as a temporary backup while you ensure the photos have been 
safely added to your main backups. It won’t replicate your working folder structure, back up any 
additional photos such as those edited in Photoshop, or remove any photos you’ve deleted, so it’s 
not a replacement for a backup system.

 Figure 27  Backup frequency is set using the Catalog 
Settings dialog.

 Figure 28  When the backup runs, you can change the 
backup location.

Lightroom’s Catalog Backup is just that—a 
backup of your catalog. Your photos are 
not stored ‘in’ Lightroom and Lightroom’s 
Catalog Backup doesn’t back up the photos.”

http://www.lightroomqueen.com/lr5quickstart
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The easiest way to back up your photos is to include them in your main system backups. You are 
running backups of your whole computer, aren’t you? Windows comes with its own Backup and 
Restore tool, and Mac OSX comes with Time Machine, both of which can back up your computer 
files to an external drive. Or, for a little more control, you can run dedicated backup or file 
synchronization software. Whichever option you choose, double check that all of your photos are 
being safely backed up, as some software excludes external drives by default.

BACK UP THE EXTRAS
Over the course of time, you’ll gather presets and templates that you’ve created or downloaded 
from other websites, so you’ll want to back those up too. You can manually copy them from their 
various locations, which are listed in the back of this book. There’s a Lightroom plug-in which backs 
up all of the Lightroom settings and manages the number of catalog backups, called TPG Backup, 
which can be downloaded from http://www.lrq.me/photogeek-backup

Figure 30   
Windows includes 
a Backup & 
Restore tool

Figure 29  Mac OS X includes 
Time Machine for backing up and 
restoring your data.

There’s a 
Lightroom 
plug-in which 
backs up all of 
the Lightroom 
settings and 
manages 
the number 
of catalog 
backups, called 
TPG Backup”

http://www.lrq.me/photogeek-backup
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Once the import dialog closes, you’ll be viewing the main 
Lightroom Interface, also known as the Workspace, so let’s do a 
quick guided tour of the basics. 

On the next page you’ll see an annotated screenshot of the Lightroom workspace or interface, 
followed by a detailed explaination of each section on the subsequent pages.

THE LIGHTROOM WORKSPACE

SHORTCUTS

G =  Grid view 
E =  Loupe view 
C =  Compare view 
N =  Survey view 
Tab =  Show/hide side panels 

Shift-Tab =  Show/hide all panels 
Shift-F =  Cycle through full screen modes 
T =   Show/hide Toolbar 
\ =   Show/hide Filter Bar

http://www.lightroomqueen.com/lr5quickstart
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Title Bar

Identity Plate
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Show/Hide 
Panel Groups

Breadcrumb Bar

 Figure 31  The Lightroom Workspace or Interface

Module Picker

Filter Bar

Preview Area

Toolbar

Filter Bar

Filmstrip
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Title Bar
The Title Bar shows the name of the current catalog, along with the standard window 
buttons. If it goes missing, along with the minimize/maximize/close buttons, press Shift-F 
once or twice to cancel the Full Screen modes.

Identity Plate
The Identity Plate allows you to add your own branding to your catalogs. You’ll find the 
settings under the Edit menu (Windows) / Lightroom menu (Mac) > Identity Plate Setup.

Panels
Panels can be opened and closed by clicking on the panel header. If you right-click on the 
panel header, you can show/hide specific panels. In that right-click menu you’ll also find 
Solo Mode, which automatically closes a panel when you open another panel in the same 
panel group. It’s particularly useful when working on a small screen. 

Show/Hide Panel Groups
The left and right hand sides are called panel groups. If you click on the black bars along 
the outer edges of the screen, you can show/hide the left/right panel groups, as well as the 
Module Picker and the Filmstrip. Right-clicking on the black bars gives additional options.

Breadcrumb Bar
The breadcrumb bar has controls for the secondary window, as well as information 
about the selected source folder or collection, the number of photos in the current 
view and the number of selected photos. If you click on it, there’s a list of recent 
sources for easy access. 

1

2

3

4

5

http://www.lightroomqueen.com/lr5quickstart
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Module Picker
The Module Picker gives you access to the Library, Develop, Map, Book, Slideshow, 
Print and Web modules. The selected module is highlighted, and you can click on 
another module name to switch modules. If you right-click on a module name, you can 
hide modules from view.

Filter Bar
When viewing Grid view, the Filter Bar will appear above the thumbnails. It allows you to 
filter the current view to only show photos meeting your chosen criteria. If it goes missing, 
press the \ key on your keyboard. You can also access the star, color and flag filters by 
clicking the word Filter on the Filmstrip.

Preview Area
The central area of the screen is the Preview Area or main work area.

Toolbar
The Toolbar gives easy access to often used tools. Press T on your keyboard if it goes missing, 
and click on the arrow at the right hand end to choose which tools show in the Toolbar.

Filmstrip
The Filmstrip is available in all modules and shows the set of photos you’re currently 
viewing. When you select a different photo in the Filmstrip, the main Preview Area will 
be updated too.

6

7

8

9

10

The Module 
Picker gives you 
access to the 
Library, Develop, 
Map, Book, 
Slideshow, 
Print and Web 
modules.”
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When the import finishes, the Previous Import collection will 
be selected in the Catalogs panel, so let’s use those newly 
imported photos to explore further. 

VIEWING YOUR PHOTOS IN GRID VIEW
The Grid view can be accessed by pressing G on the keyboard or by clicking the Grid view button 
on the Toolbar. Grid view shows a page of thumbnails, and you can change the thumbnail size 
using the slider on the Toolbar.

Press the J key on your keyboard 3 times to cycle through the available thumbnail cell styles and 
view additional information about your photos. Go to View menu > View Options to control the 
information shown on your thumbnail cells.

VIEWING YOUR PHOTOS IN LIGHTROOM

 Figure 32  The 4 view modes buttons on 
the Toolbar. From left to right, they are 
Grid, Loupe, Compare and Survey modes.

Figure 33  The simplest cell style (left) just 
shows the thumbnail photo. The compact 
cell (center) and extended cell (right) show 
additional information of your choice. 

http://www.lightroomqueen.com/lr5quickstart
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 Figure 34  The View Options dialog is accessed from the View menu and controls the information 
displayed in Grid and Loupe modes. These are my preferred settings for Grid view.

Go to View menu > View 
Options to control the 
information shown on your 
thumbnail cells.”
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Index Number
Index number shows the number of 
photo in the current view.

Cell Border
Clicking in the cell border deselects all other photos.

Rotation
The Rotation arrows only show when you 
float over a thumbnail.

Badges
The Badges give you additional information about the settings 
applied to the photo. From left to right, they are: map location, 
collection membership, keywords, crop, Develop settings.

Quick Collection
The marker shows as a grey circle when the photo is in the Quick 
Collection. If the photo isn’t in the Quick Collection, the outline of 
the circle onlys appears when you hover over the thumbnail. Click to 
add or remove the photo from the Quick Collection.

Thumbnail
When dragging photos, drag by the thumbnail itself, not the cell 
border.

Metadata Status
The metadata status warns you when the file metadata conflicts 
with Lightroom’s metadata, or when the file is missing or corrupted.

Bottom Label
The information is selected in the View Options dialog. Here it 
shows star ratings and color label.

Flag
The flag state can be unpicked (invisible until you float over it), 
picked (white flag) or rejected (black flag).

Top Label
The information is selected in the View Options dialog. In this 
screenshot it’s set to ‘File Base Name and Copy Name’.

Virtual Copy
A photo can have multiple versions of settings. These virtual copies 
are marked with a turned corner.

Stack
The Stack indicator shows how many photos are grouped together 
and the double lines show the beginning and end of the visible 
stack. They’re shown here on both sides as the stack is closed.

http://www.lightroomqueen.com/lr5quickstart
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SELECTIONS
Lightroom has 3 different levels of selection, or 2 levels of selection plus a deselected state, 
depending on how you look at it.

The lightest shade of grey is the active photo. That’s the single photo that would be shown 
in Loupe or in the Develop module. If you’re synchronizing settings across multiple photos, 
Lightroom will take the settings from that active photo and apply it to the other selected photos.

The mid grey is also selected, but is not the active photo. In Grid view, any changes will apply to 
all of the selected photos. In other views, if you’re synchronizing settings across multiple photos, 
Lightroom will apply the settings to those photos.

The darkest shade of grey isn’t selected.

When applying settings, or especially when deleting photos, double check how many photos are 
selected, otherwise you could accidentally apply a command to all of them. 

VIEWING YOUR PHOTOS IN MORE DETAIL
The thumbnails give you a good overview, but they’re a little too small to see the detail in your 
photos, so Lightroom offers 3 further view modes —Loupe, Compare and Survey—each with 
different strengths.

ONE PHOTO OR ALL?

Lightroom’s Grid view behaves 
differently to other views—anything you 
do in Grid view on the primary monitor 
applies to all selected photos, whereas 
most other views only apply to the 
active or most-selected photo (unless 
you have Auto Sync turned on—there’s 
always an exception!)
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VIEWING YOUR PHOTOS IN LOUPE VIEW
The Loupe view shows a larger view of one photo at a time. To access Loupe view, click the Loupe 
button on the Toolbar or press the E key.

You can move from one photo to the next, using the left and right arrows on the keyboard, the 
arrows on the Toolbar beneath the photo, or by selecting another photo from the Filmstrip.

To zoom in to check details, press the Z key or Spacebar. By default it zooms into 1:1 or 100% view, 
but there are additional zoom ratios at the top of the Navigator panel. If you want to view your photo 
as full screen, press the F key to toggle in and out of Full Screen Preview view. 

VIEWING YOUR PHOTOS IN SURVEY VIEW
Survey mode allows you to view multiple photos at the same time, so it’s particularly useful when you 
have a series of similar photos to narrow down. 

Select the photos in Grid or Filmstrip. If they’re consecutive photos, click on the first photo, then hold 
down Shift key and click on the last one. If the photos are scattered, hold down Ctrl (Windows) / Cmd 
(Mac) while clicking on their thumbnails. Once the photos are selected, press the Survey button on the 
Toolbar or press N.

To remove a photo from the Survey view, click the X in corner of the photo. When you go back to 
Grid view, only the leftover photos will still be selected, so you can mark them using the ranking 
system of your choice.

Figure 39  Enter Compare mode by clicking 
this button in the Toolbar or by pressing C.

Figure 38  Enter Survey mode by clicking this 
button in the Toolbar or by pressing N.

 Figure 37  Loupe view gives a detailed 
view on a single photo, allowing you to 
zoom in to check the detail. The zoom 
ratios are in the Navigator panel.

Figure 36  Enter Loupe mode by clicking this 
button or by pressing E.

http://www.lightroomqueen.com/lr5quickstart
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 Figure 43  Compare mode compares 
2 photos in great detail, choosing your 
favorite before moving onto the next pair.

 Figure 42  Survey mode allows you to view 
multiple photos at the same time

 Figure 41  Loupe view gives a detailed view on a single photo, allowing you to zoom in to check the detail.
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VIEWING FOLDERS IN LIGHTROOM AND ON THE HARD DRIVE
Using a database to catalog photos is a new concept to many Lightroom users, so it’s important to 
understand how the photos in Lightroom relate to the files on your hard drive.

Look at the Folders panel on the left hand side of the Library module. You may have one or more 
folders listed, but the folder structure probably won’t match your hierarchical folder structure in Explorer 
(Windows) or Finder (Mac). Only folders that hold imported photos will show in the Folders panel.

To make it easier to visualize where the photos are stored on your hard drive, we can set up the same 
hierarchy.

1. Find a top level folder. In Figure 44, all of the folder names starting with 
2010 are top level folders, as are the 2012 and 2013 folders.

2. Right-click on that top level folder and choose Show Parent Folder, from the menu. If that 
option doesn’t appear in the menu, you’ve selected a folder that already has a parent folder.

3. In most cases, you’ll only need to add a single parent folder, but if 
you have a deep nested hierarchy, you may want to repeat on the 
new top level folders until you can visualize the whole tree.

PHOTOS ARE NOT IN LIGHTROOM

Remember, photos are never IN 
Lightroom. Don’t move, rename or delete 
files or folders using Explorer/Finder or 
other software after import as Lightroom 
will no longer be able to find them.

Figure 44  The 
initial view of the 
Folders panel may 
not be easy to relate 
to the folders on the 
hard drive

Figure 45  Using Show Parent 
Folder to add additional parent 
folders into the Folder panel view 
makes it easier to visualize how 
Lightroom relates to the hard drive.

http://www.lightroomqueen.com/lr5quickstart
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Figure 47   
The end result of the 
process is a familiar 
folder hierarchy.

Figure 46   
After using Show 
Parent Folder on 
2010-01-01 Sunset, 
the folder view is an 
improvement, but 
we still can’t see 
where that folder’s 
stored on the hard 
drive, so Show 
Parent Folder on 
the 2010, 2012 or 
2013 folder.

Figure 48   
The same folder 
hierarchy shown 
in Windows 
Explorer.  
 
This is viewing 
the folders on 
Macintosh HD over 
the network, but 
the same would 
apply if it was 
viewing a folder 
on a Windows 
hard drive.

Figure 49   
The same folder 
hierarchy shown in 
Mac Finder.
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Having explored the view modes, you’ll be ready to start sorting 
through the photos. Select the Previous Import collection or 
another folder and we’ll explore the options.. 

RATING YOUR PHOTOS
Lightroom offers 3 different ways of ranking your photos.

Flags have 3 different states—flagged (picked), unflagged and rejected. They’re a popular ranking 
system among Lightroom users, but flags are not shared with other software.

Star ratings are used by photographers worldwide, with 5 stars being the best photos. Stars are 
standardized metadata so they can be understood by other software. Many photographers limit 
themselves to using 1-3 stars when initially ranking their photos, and leave 4 and 5 star for the 
best photos they’ve ever taken.

SELECTING THE BEST PHOTOS

SHORTCUTS

P = Pick flag  
U = Unflag 
X = Reject flag 
0-5 = 0-5 stars 
6-9 = Red, yellow, green & blue label 
Caps Lock = auto-advance

If you haven’t decided which system to 
use yet, consider using the Reject flag 
to mark photos to be deleted, and star 
ratings to grade the quality of the photos.”

http://www.lightroomqueen.com/lr5quickstart
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MULTIPASS EDIT

Some people prefer to take multiple 
passes through the photos when 
ranking—perhaps mark as reject or 1 star 
the first time and then go through the 1 
star photos again, marking the best ones 
as 2 stars. You may need to experiment 
before deciding which workflow

Figure 50  Buttons for flags and star ratings are on the 
Toolbar by default, but if you click the arrow at the right-
hand end, you can choose additional options to show on 
the Toolbar.

Color labels have no specific meaning, so you can decide how to use them. Many use them to mark 
photos that will need further work in other editors, for example, photos that need retouching in 
Photoshop, sets of photos for merging into HDR, photos to be built into a panorama, etc.

If you haven’t decided which system to use yet, consider using the Reject flag to mark photos to 
be deleted, and star ratings to grade the quality of the photos.

Let’s start ranking the photos you’ve just imported.

1. Turn on the Caps Lock key on the keyboard to automatically advance to 
the next photo. If you prefer not to automatically move on, you can use 
the left/right arrows on the keyboard to move between photos.

2. Select the first photo and switch to the Loupe mode.

3. Decide how much you like the photo on screen. Press they X key to mark 
it for deletion, or the 1, 2 or 3 keys to give it a star rating. If you prefer 
to use the mouse, click the buttons on the Toolbar instead.

4. Repeat the process until you get to the end of photos. 
Remember, you can change your mind later!

5. If you find a group of similar photos, you can switch to Compare mode or Survey 
mode to view them together and then mark the best ones from the group.

6. Don’t forget to turn off the Caps Lock key when you’ve finished!
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DELETING FUZZY PHOTOS
Even the best photographers sometimes end up with photos that aren’t worth keeping.

It’s possible to delete photos while you’re sorting through them, simply by pressing the Delete key on 
your keyboard, but it’s quicker to mark them with a Reject flag and then delete them in one go. 
Photos marked as rejects show in the Grid view as dimmed photos, so it’s easy to check that you’ve 
marked the right ones. When you’re ready to delete all of the rejected photos, go to Photo menu > 
Delete Rejected Photos.

Before Lightroom deletes the photos, it will ask whether to Remove or Delete them. Note the 
difference. Remove just removes the reference to the photo from Lightroom’s catalog, but the photo 
remains on the hard drive. Delete deletes the photo from your hard drive too.

Before you select either option, double check the number of photos that it says will be deleted, just in 
case you’ve accidentally selected photos you want to keep.

 Figure 51  In the Delete dialog, note the difference 
between Remove and Delete, and don’t forget to check the 
number of photos that will be deleted.

DELETE IN COLLECTIONS

If you press the Delete key while viewing 
a collection, it will only remove the 
photo from that collection, instead of 
removing it from Lightroom’s catalog 
and the hard drive. 

Before Lightroom deletes the photos, it will 
ask whether to Remove or Delete them. 
Remove just removes the reference to the 
photo from Lightroom’s catalog, but the 
photo remains on the hard drive. Delete 
deletes the photo from your hard drive too.”

http://www.lightroomqueen.com/lr5quickstart
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GROUPING SIMILAR PHOTOS USING STACKS
While you’re sorting through your photos, you may come across groups of photos that don’t mean a 
lot on their own. For example, groups of photos taken for a panorama or HDR often look really bad as 
individual photos!

Lightroom offers stacking as a way to group those photos and show them as a single photo while 
you’re browsing.

Select the photos and go to Photo menu > Stacking > Group into Stack, or press Ctrl-G (Windows) / 
Cmd-G (Mac).

The photos will then be collapsed into a stack, marked with double lines at the beginning and end.
To open the stack, click on the white number in the corner. The photo on the left is the photo that 
shows when you view a collapsed stack.

If the photo that best represents the stack—
perhaps the finished panorama or the finished 
HDR photo—isn’t currently at the top of the 
stack, click on its number and it will move to 
the top and will show in the Grid when the 
stack is collapsed.

Figure 53  When you click on the white rectangle, the 
stack opens to show the group of photos.

 Figure 52  Collapsed stacks show as a single photo.
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COLLECTIONS
Collections are a way of grouping photos without moving them on the hard drive. That means the 
same photo can be in multiple different collections, and the photos in the collections can be stored in 
various different folders.

To create a collection, scroll down to the Collections panel, which you’ll find in the left panel group 
in all modules, and click the + button at the top. Name the collection, and you’ll see it added to the 
Collections panel.

From the Grid view, select photos and drag them from the thumbnail preview area onto the collection. 
Don’t forget to grab the photos by the thumbnail itself, not the border surrounding it.
If you create a Collection Set using the same + button on the Collections panel, you can drag existing 
collections inside the set to group similar collections.

 Figure 54  Groups of photos are called Collections, and 
they’re stored in the Collections panel. Special types of 
collection can also contain settings for output modules, 
such as books and slideshows. 

 Figure 55  To create a Collection, click the + button on 
the Collections panel and enter the name in the Create 
Collection dialog.

Collections are a way of grouping photos 
without moving them on the hard drive. 
That means the same photo can be in 
multiple different collections, and the 
photos in the collections can be stored in 
various different folders.”
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Once you’ve finished selecting your favorite photos, it’s time to add metadata to help 
you find them again later. Sorting through your photos first means you can focus 
your efforts on the best ones, which are the ones you’re likely to want to find again.

TITLE & CAPTION
Some photographers like to add descriptive text to the photos, perhaps for use as captions when 
posting to Flickr or Facebook. Go to the Metadata panel to type directly into the metadata fields.
The Title and Caption fields do have official IPTC definitions, but many photographers simply use 
Title for a short image title (i.e. Dogs in Snow) and Caption for a more descriptive paragraph (i.e. 
William and Charlie are playing in the snow in the back garden).

KEYWORDS
Keyword Tags are text metadata used to describe the photo. For example, they can include:

 • who is in the photo (people)
 • what is in the photo (other subjects or objects)
 • where was the photo taken (location)
 • why was the photo taken (what’s happening)
 • when was the photo taken (time of day, season, event)
 • how was the photo taken (perhaps HDR, tilt-shift, panoramic)

ADDING METADATA TO YOUR BEST PHOTOS
Figure 56   
Enter your Title 
and Caption in the 
Metadata panel.
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TYPES OF METADATA

EXIF data is technical information 
added by the camera at the time of 
capture. It includes camera and lens 
information such as the make and 
model, and image information such as 
the capture date/time, shutter speed, 
aperture, ISO, and pixel dimensions.

IPTC data is added by the photographer 
to describe the photo, for example, 
title, caption, keywords and the 
photographer’s name and copyright. 
There are official definitions for the 
IPTC fields, and you can view the full 
IPTC specification at the IPTC website.

They help you search for photos later, for example, searching for keywords ‘Charlie’ and ‘snow’ will show 
just the photos of Charlie playing in the snow, without having to search through your whole catalog.

The main aim is to be able to find the photos again later, so don’t go overboard, especially to start 
with. If you try to add 30 keywords to every photo you’ve ever taken, it can quickly become an 
overwhelming job, so just start with a few significant keywords on your best photos.
There are multiple ways to add keywords, so we’ll just cover 2 options in this Quick Start section.

Type in the Keywording panel
Select the first photo, perhaps in Loupe view, and go to the Keywording panel in the right panel 
group in Library. Click in the keywords field that says ‘Click here to add keywords’ and type your 
keywords, separating them with a comma (,). As you start to reuse keywords, they’ll be suggested 
as you start typing, which helps avoid differences in spelling.

When you’ve finished, press the Enter key. Your keywords will then appear in the Keyword List panel.

Create and apply keywords using the Keyword List panel
At the top of the Keyword List panel is a + button, which is used for creating new keywords. Click 
the + button and enter your keyword in the Create Keyword Tag dialog.

To assign your new keyword to the selected photo, click the square to the left of the keyword in the 
Keyword List panel, which adds a checkmark.

If you want to add the same keyword to a lot of photos, for example, you have a series of photos of 
snow, select them all in Grid view before typing the keyword in the Keywording panel or checking 
the checkbox in the Keyword List panel.

http://www.lightroomqueen.com/lr5quickstart
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Simply adding keywords will create a flat list of keywords, but what if you want to group them to 
make them easy to find? You may want to group all of your family members names into a ‘People’ 
parent keyword, and different animals under a ‘Animals’ parent keyword. To do so, create the 
People and Animals keywords and then drag and drop the other keywords onto them, just as you 
would drag folders onto other folders to make them into subfolders.

Figure 59  A subset of my personal keyword list.

Figure 58  Alternatively, you can click the + button on the 
Keyword List panel to view the Create Keyword Tag dialog.

 Figure 57  You can add keyword tags to your photos by 
typing them directly into the Keywording panel.
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MAP LOCATIONS
Lightroom’s Map module allows you to sort and manage your photos by location. Some photos, for 
example, those shot on mobile phones, will automatically appear on the map as they include GPS data. 
Lightroom also allows you to add that information manually by dragging and dropping the photo onto 
the map. It’s also possible to match the photo with a separate GPS Track Log.

Switch to the Map module by selecting Map in the Module Picker at the top of the screen, and make 
sure the Filmstrip is showing at the bottom of the screen.

On the Toolbar below the map is the Zoom slider, which allows you to zoom in and out of the map. 
Once you’ve zoomed in, click and drag the map to move it around.

If you want to go straight to a specific location on the map, type the name in the Search Box at the top 
of the map.

Finally, you can add your photos to the map, simply by dragging the photos from the Filmstrip onto your 
chosen location. If you make a mistake, drag them from the Filmstrip again, to the correct location.
When you drop the photos on the map, a yellow or orange marker will appear, and clicking on that 
marker will show the photos at that location.

 Figure 60  When you open the Map module, the Map Key 
overlay will be showing. Close it by clicking the X in the 
top right corner.

Figure 61  Search for a specific location using the 
Search Box at the top of the map.

http://www.lightroomqueen.com/lr5quickstart
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Figure 63  Click on a pin to view all of the photos taken 
at that location.

 Figure 62  Drag photos from the Filmstrip onto the map.

Add your photos to the map by 
dragging them from the Filmstrip 
onto your chosen location.”



ADOBE PHOTOSHOP LIGHTROOM 5 - QUICK START GUIDE

48 www.lightroomqueen.com/lr5quickstart

Using the metadata automatically embedded by the camera, as 
well as the metadata you’ve added, you can search the database 
to easily find specific photos. 

CHANGING THE SORT ORDER
The simplest way of finding your photos is changing the sort order and then scrolling through the 
Grid view to find the photo you want. On the Toolbar in Grid view, you’ll find the Sort Order pop-
up, which includes Capture Time, Filename and other useful options. The A>Z button reverses the 
current sort order.

USING FILTERS
Scrolling through the photos works well if you only have a few photos, but it can take a long time 
if your photo library has grown. That’s where Filtering comes in—it hides all of the photos that 
don’t meet the criteria you choose. For example, you may only want to view the photos with 3 or 
more stars, or all of the photos taken with a specific camera, or the photos you’ve tagged with a 
specific keyword.

To search your whole catalog, first select All Photographs in the Catalog panel in the left panel 
group in Library module, and select the Grid view. Above the thumbnails is the Filter bar, which 
you can show and hide using the \ key. Click on the word Attribute and then click on the 3rd star. 
All of the 0, 1 and 2 star photos will disappear from view, leaving only the 3, 4 or 5 star photos 
showing.

FINDING AND FILTERING YOUR PHOTOS

 Figure 65  To search the whole catalog, select All 
Photographs in the Catalog panel.

 Figure 64  The Sort Order controls are in the Toolbar 
below the Grid.

http://www.lightroomqueen.com/lr5quickstart
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Figure 66  Lightroom’s Filters can be combined to find a 
specific photo.

Click on the 3rd star again, and the other photos will reappear. Then click on the red rectangle, 
and only the red labeled photos will show. Finally, try clicking the 2nd star, while leaving the red 
rectangle highlighted. Now the photos with 2 stars or greater and a red label will be showing. 
Also on the Attribute Filter bar are the flags and virtual copy filters. You can combine various 
different attributes to find the photos you’re looking for.

Click on the word Attribute again to hide the Attribute Filter bar, and then click on the Metadata 
label to show the Metadata Filter bar.

The Metadata Filter bar has 4 columns by default. Using the pop-up at the top of each column, 
you can control which criteria you want to search, for example, Date, File Type, Camera and 
Keyword are among the most popular options.

Filtering hides 
all of the photos 
that don’t meet 
the criteria you 
choose.”
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Let’s search for all of the photos shot in 2013 using an iPhone containing the keyword Charlie. In 
the first column, which is set to Date, click on 2013 to highlight it. The photos from other years 
will disappear from the grid below. In the second column, which is set to Camera, click on the 
iPhone. At this point the grid only shows iPhone photos from 2013. Finally, select Keyword from 
the third column pop-up, and then select Charlie from the list below.

You could then click on the Attribute label to add a 3 star filter, which would then show only the 
2013 iPhone photos of Charlie with 3 stars.

To cancel the filters and return to viewing all of the photos, press the word None.

USING SMART COLLECTIONS
We talked earlier about using Collections to manually group photos, but Smart Collections are 
more like Saved Searches or Smart Folders.

Photos automatically appear in the Smart Collection when they meet the criteria you choose, and 
they disappear again when they stop meeting that criteria. For example, you can create a Smart 
Collection of all the 3+ star photos, so you can quickly view your best work without having to go 
to All Photographs and set up a filter.

To create a Smart Collection, press the + button on the Collections panel and select Create 
Smart Collection. Give it a name and then enter your criteria. The + button at the end of the row 
creates an additional row. Our earlier example of 2013 iPhone photos of Charlie with 3 stars and 
a red label would be set to match 5 rows of criteria, shown in the screenshot.

When you press Create, your new Smart Collection will stay in the Collections panel and you can 
click to view it again at any time.

 Figure 68  Smart Collections are like Saved Searches, 
automatically updating as photos meet, or stop meeting, 
the criteria you choose.

Figure 67  Smart 
Collections are 
stored in the 
Collections panel.
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One of the first things photographers want to do is edit their photos. Lightroom 
excels at that, so let’s explore the most frequent adjustments made using the 
Develop module.

BASIC ADJUSTMENTS
Most of your image adjustments will be performed using the Basic panel on the right hand side 
in the Develop module. Just because there are a lot of sliders doesn’t mean you have to adjust 
every single one!

It’s most efficient to work from the top down, and then go back and tweak earlier sliders again if 
needed. However many times you move a slider, it doesn’t degrade the image quality because the 
adjustments are saved as text instructions and only applied to the on-screen preview.

Let’s cover a quick summary of the sliders, then we’ll work on some examples.

1. It sounds obvious, but look at the photo carefully first, and decide what you want to change. Is 
it too dark? Too light? A bit cold? Has it lost detail in the highlights? Is it a bit flat and lacking 
contrast? Is there lens distortion? If you jump straight in without analyzing the photo, you can 
spend a lot of time making adjustments and going in circles.

2. If the photo’s very under or over exposed, adjust the Exposure slider to get the overall exposure 
in the right ballpark, but don’t worry about fine tuning yet.

EDITING THE BEST PHOTOS

 Figure 69  You’ll make most of your image adjustments 
using the Basic panel in the Develop module.
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3. The White Balance sliders (Temperature & Tint) compensate for the color of the light in which 
the photo was taken. For example, a photo taken indoors without flash may be too yellow. The 
quickest way to set the white balance is to select the White Balance Selector tool and click on 
something in the photo that should be almost white or light grey. You can then go back and fine 
tune the white balance by adjusting the sliders, which are colored to show their range. Move the 
Temperature slider left to make the photo cooler or to the right to make it warmer. If the photo 
is too pink or green, adjust the Tint slider too.

4. Adjust the Exposure slider to set the overall brightness of the photo, moving to the right to 
brighten the photo or to the left to darken it. The easiest way to decide the correct Exposure is 
to look at the little Navigator preview in the top left corner while you move the slider, so you’re 
not distracted by the content of the photo.

5. The Contrast slider is next. Does the photo look a little flat and muddy? Try increasing the 
Contrast by moving the slider to the right.

6. The Highlights and Shadows sliders affect the light and dark areas of the photos. If the light 
areas are lacking detail, try moving the Highlights slider to the left to darken them slightly. If 
the dark areas and shadows are lacking detail, try moving the Shadows slider to the right to 
lighten them slightly.

7. In many cases you can skip the Whites and Blacks sliders, as they’re primarily for fine-tuning settings.

8. Clarity adds ‘punch’ to the photos. On photos of people, only use very low values as you’ll 
accentuate lines and wrinkles, but architecture and landscapes can benefit from slightly 
higher values.

9. If the colors in your photo are a little dull, try increasing the Vibrance slider. It adjusts how 
saturated or colorful your photos are. Vibrance is more intelligent than the Saturation slider.

 Figure 70  Select the White Balance Eyedropper from 
the Basic panel and click on something that should be 
neutral to correct a color cast..

CLIPPING WARNING

If you need to check whether you’re 
losing highlight or shadow detail, turn 
on the clipping warnings by clicking 
the triangles in the top left and right 
corners of the histogram or by pressing 
J. Clipped blacks show in blue and 
clipped whites shows in red.
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WHY DO MY RAW FILES NOT 
LOOK LIKE THEY DID ON MY 
CAMERA?

Raw files are unprocessed sensor data, 
so the raw converter has to convert the 
raw data into an image. 

The camera manufacturers, and 
different raw processors, have their 
own interpretation of that data. There 
is no right or wrong—it’s just different.

If you prefer the camera 
manufacturer’s rendering, Lightroom 
ships with emulation profiles for some 
cameras (mainly Canon and Nikon 
SLR’s), which makes Lightroom’s 
rendering look more like the camera 
manufacturer’s rendering. If your 
camera has emulation profiles, you’ll 
find them in the Profile pop-up in the 
Calibration panel in Develop. Select 
your chosen profile before making 
other Develop adjustments, as they 
will change the appearance.

Let’s try some examples… you can download these 3 files to try yourself at 
http://www.lightroomqueen.com/lr5quickstart

Figure 71  We have a photo of William playing in the snow, but the snow fooled the automatic metering 
so it’s underexposed. Adjust the Exposure slider to get it in the right ballpark. We can then see it’s quite 
warm, and snow should be cool, so we adjust the White Balance. That’s better, but it’s a bit flat and lacking 
contrast, so we increase the Contrast slider. Let’s reduce the Highlights to bring back detail in the snow, and 
increase the Shadows to show more detail in the side of his face. Finally, we’ll add a touch of Clarity to make 
it jump off the page.

http://www.lightroomqueen.com/lr5quickstart
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Figure 72  Next, let’s try a sleepy tiger. 
The White Balance and Exposure are about 
right, but it’s very flat—so we’ll adjust the 
Contrast and Clarity. It’s still a little dull, so 
we’ll make it more colorful using Vibrance.

http://www.lightroomqueen.com/lr5quickstart
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Figure 73  Finally, let’s improve a high 
contrast scene. The White Balance and Exposure 
are about right, but it’s losing detail in the 
light areas on top of the umbrella and in the 
shadows on the left and right. If we reduce the 
Contrast, to bring back that detail, it makes it a 
bit flat, so instead, we’ll reduce the Highlights 
slider and increase the Shadows slider. There 
are no people in the photo, so we can safely 
add some Clarity to add a little punch and 
a little Vibrance to bring out the colors.

These are, of course, only simple 
examples to get you started. Now you can 
experiment with your own photos.
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UNDOING EXPERIMENTS
Because Lightroom’s non-destructive, you can easily undo any of the adjustments.

As in most programs, Ctrl-Z (Windows) / Cmd-Z (Mac) is the Undo command. That will undo your 
last action, whether that’s a slider movement, a star rating, or simply switching between modules.
Lightroom also keeps a record of all the changes made to each photo. You can see that list in the 
History panel, on the left in Develop module. To go back to an earlier version, click on an earlier 
history state in the History panel. If you make further changes, Lightroom will continue recording 
from that point.

Finally, if you really don’t like the results of your experiment, you can press the Reset button at the 
bottom of the right hand panels, to reset the photo’s settings back to their default.

BEFORE/AFTER PREVIEW
Once you’ve done your initial edits, you’ll want to see the results of your hard work. The Before/
After Preview allows you to compare your current settings with an earlier version, using your current 
crop settings.

Press the \ key to toggle back and forth between before/after, or the Y key to see them side-by-
side. The Y button on the Toolbar offers further options.

VIRTUAL COPIES
If you want to experiment with different settings, without overwriting your current version, you can 
create a Virtual Copy. Virtual Copies show up in Lightroom as duplicate photos, and they have their 
own metadata and settings. Because they’re virtual, they don’t take up much more space on your 
hard drive as Lightroom doesn’t need to duplicate the original image file.

 Figure 75  Before/After view options appear in the 
Toolbar.

 Figure 74  The History panel records the changes you 
make in the Develop module, as well as exports.

Figure 76  Virtual Copies 
can be identified by the 
triangular page turn icon in 
the corner of the thumbnail.
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To create a virtual copy, right-click and choose Create Virtual Copy or use the shortcut Ctrl-‘ 
(Windows) / Cmd-‘ (Mac).

You’ll see an additional copy appear next to the Master, and it’ll have a small triangle in the corner 
of the thumbnail, indicating that it’s a VC.

If you no longer want a Virtual Copy, you can delete it like any other photo. Deleting a Virtual Copy 
won’t remove the original photo from the hard drive—only a Master can do that. It will only remove 
that version of the metadata.

CROPPING & STRAIGHTENING
Most photos benefit from cropping, whether to remove distracting objects, straighten horizons, for 
artistic effect, or simply to fit your chosen ratio.

To open the Crop tool, select the Crop icon in the Develop Tool Strip below the Histogram or press 
the R key.

First, straighten your horizon. Select the Straighten tool in the Crop Options panel, and then click and 
drag a line along the horizon. Lightroom will automatically rotate the photo to make that line straight.

If you’re planning on printing the photo, you may want to restrict your crop to a standard ratio. As 
Lightroom never throws away pixels, it doesn’t crop to a specific size—just a ratio. This enables you to 
reuse the same crop for multiple different sizes, for example, a 4x5 crop can be output as 800x1000 
pixels, 4”x5”, 8”x10”. You can select the ratio in the Crop Options panel, and choose the size when 
you export the photo. For a free form or non-standard crop ratio, leave the Lock icon unlocked.

Figure 78  Straighten the photo by selecting the Straighten 
Tool and dragging a line along the horizon.

 Figure 77  To open the Crop tool, select the first icon in 
the Tool Strip, and the options will appear below..
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To switch the orientation, for example, to make a vertical crop from a horizontal photo, press the X key.
Adjust the crop by dragging the corners or the edges of the Crop Border. You can move the photo 
around under the Crop Overlay by clicking and dragging the photo, and rotate by clicking and 
dragging around the outside of the Crop Border.

Once you’ve finished cropping, press the Enter key or the Done button on the Toolbar.

SHARPENING
Your photos may need a little sharpening, so zoom into 1:1 view by clicking the 1:1 icon on the top 
of the Navigator panel. Other zoom ratio’s won’t be as accurate.

Lightroom’s Sharpening controls are in the Detail panel in the Develop module.

The Amount slider controls the amount of sharpening applied. By default, that will be set to 0 for 
JPEGs as they may have been sharpened by the camera. Raw files are set to 25 by default.
The default settings are an excellent starting point and you may be satisfied with those settings. If 
you want to experiment further, try lower radius/higher detail for detailed shots such as landscapes 
and higher radius/lower detail settings for close-up portraits.

In the Presets panel, there are a couple of sharpening presets for faces and landscapes.

Be careful not to oversharpen, as you can also apply Output Sharpening when you come to export 
the photos later.

 Figure 79  Sharpening and Noise Reduction 
are applied using the Detail panel.
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FIXING NOISY PHOTOS
Noise in your photos can be very distracting. You’ll particularly notice it in photos shot at high ISO, 
for example, shot without flash in a darkened room. If you’ve increased the exposure considerably 
within Lightroom, that can also increase the appearance of noise. Fortunately, Lightroom’s Noise 
Reduction tools are excellent.

As with sharpening, zoom into 1:1 view as other zoom’s aren’t as accurate.

In the Detail panel there are a range of noise reduction sliders for extreme cases, but you’ll usually 
only need to adjust Luminance and perhaps Color.

If you’re working on raw files, try a setting of around 20-25 as a starting point. That will reduce the 
noise in most cases, without losing too much image detail. The aim is to reduce the noise, rather 
than making the subject look like plastic, so don’t push it too far. JPEGs may have already had 
some noise reduction applied by the camera, so you’ll need a lower value for those.

The Color slider is set to 25 by default for raw files, which is usually plenty. It’s set to 0 by default 
for JPEGs, but if there is still colored noise in your photo, particularly in the dark shadows, try 
increasing it slightly.

FIXING DISTORTION
Your photos may be distorted, either because of defects in the lens itself or because of the 
shooting angle. Applying lens and perspective corrections in Lightroom is as simple as checking the 
checkboxes in the Basic tab of the Lens Corrections panel.

The Enable Profile Corrections checkbox applies the lens profile. If the photo doesn’t change, switch 
to the Profile tab to select the correct lens profile from the pop-ups. Many lenses have already been 

Figure 81  Check 
the right profile 
is selected in the 
Profile tab.

Figure 80  Lens 
and perspective 
corrections are 
found in the Lens 
Corrections panel.
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profiled, but if your lens isn’t available, it may be possible to download a user-created profile using 
the Lens Profile Downloader. http://www.lrq.me/lensprofilecreator

The Remove Chromatic Aberration checkbox removes any fringing in the photo, particularly 
around high-contrast edges or in the corners of the photo. It’s not enabled by default as it can 
have a slight performance hit and soften the photo very slightly, but it’s an easy fix if there is 
fringing in your photo.

Constrain Crop makes sure that your photo is cropped to remove any gaps around the edge of the 
photo, which can occur when applying any lens or perspective corrections.

Finally, you can press the Upright Auto button to apply automatic perspective adjustments. Most 
of the time, Auto will be the best choice, but you can try the other Upright buttons to see if you 
prefer the result.

CONVERTING PHOTOS TO BLACK & WHITE
Converting your photo to black and white is very simple—just press the V key or select B&W at 
the top of the Basic panel. Lightroom will create a basic black & white photo, which you can 
then fine tune.

Go to the B&W panel and click on the Targeted Adjustment Tool in the top left corner to select 
it. The Targeted Adjustment Tool—or TAT Tool, for short—allows you to adjust the B&W mix by 
dragging directly on the photo. It moves the sliders for you.

 Figure 82  Convert to B&W using the 
button at the top of the Basic panel.

 Figure 83  Fine tune the B&W mix using the B&W panel.
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Find an area of the photo that you’d like to be darker—perhaps the blue sky—and click and drag 
down on that area. As you drag, the blue tones will get darker and you’ll see sliders in the B&W 
panel moving. Find another color in the photo that you’d like to be lighter—perhaps something red—
and as you click and drag up the red tones will lighten.

You may also want to adjust the contrast of the photo, to better suit the B&W version. You can go 
back to the Basic panel and adjust sliders there, or you can select the TAT Tool in the Tone Curve 
panel. It works just like the TAT Tool in the B&W panel, except it adjusts the Tone Curve.

COPYING SETTINGS TO SIMILAR PHOTOS
Lightroom is a workflow tool, so it’s designed to work with multiple photos. If you shoot a series of 
photos in very similar light, you may want to copy settings from one photo to the other similar photos. 
There are multiple ways to do that, but here are two…

Sync
Sync uses the data from the active (lightest grey) photo, and pastes it onto all of the other selected 
(mid-grey) photos. That’s why there are 3 different levels of selection.

1. Adjust the first photo, which will be the source of the settings.

2. Keeping that photo active, also select the other photos by holding down Ctrl (Windows) / Cmd 
(Mac) or Shift key while clicking directly on their thumbnails, rather than the cell borders.

3. Click the Sync button in the Develop module, or Sync Settings in the Library module, to show 
the Sync Develop Settings dialog.

4. Select the checkboxes for the slider settings that you want to copy to the other selected photos, 
and then press Synchronize to transfer the settings.

 Figure 84  Sync is at the bottom of the right panel group.

If you shoot a 
series of photos 
in very similar 
light, you may 
want to copy 
settings from one 
photo to the other 
similar photos.”

 Figure 85  Copy and Paste are at the bottom of the left 
panel group.
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Copy and Paste
Copy and Paste allows you to copy settings into memory, and then paste them onto individual photos.

1. Adjust the first photo, which will be the source of your settings.

2. Click the Copy button in the Develop module.

3. Select the checkboxes for the slider settings that you want to copy.

4. Press the arrow key on your keyboard to move to the next 
photo, or select a different photo in the Filmstrip.

5. Click the Paste button to paste those settings onto the selected photo.

You don’t have to copy all of the settings. Sync and Copy/Paste both have dialogs allowing you to 
choose specific settings to transfer, so you may just sync Noise Reduction or White Balance, for 
example, without copying the Exposure settings.

SAVING SETTINGS TO APPLY TO OTHER PHOTOS
Presets save sets of settings to apply to other photos over and over again. They simply move sliders 
to preset positions.

Some presets ship with Lightroom, so you can experiment with them before creating your own 
presets.

Go to Presets panel on the left in Develop. As you float over the preset names, it shows a preview 
in Navigator panel above. 

Figure 86  When you float the mouse over a preset name, it’s previewed in the Navigator panel above.
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To apply a preset to your photo, simply click on 
the preset name.

To create your own preset, adjust a photo to 
the settings that you want to save as your 
preset. Press the + button on the Presets panel 
to show the New Develop Preset dialog.
Check or uncheck the sliders you want to save 
in your preset. If a checkbox is unchecked, that 
slider won’t be adjusted when you apply your 
preset to another photo. For example, if your 
preset is just for Sharpening settings, uncheck 
the other checkboxes and only leave the 
Sharpening checkbox checked.

Give your new preset a name, and you can also 
create folders to group similar presets together. 
Then press the Create button. Your preset will 
now appear in the Presets panel for use on any 
photos.

Figure 87  Create a new preset by pressing the + button 
on the Presets panel and checking the sliders you want to 
include in the preset.
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REMOVING DUST SPOTS
Lightroom’s Spot Removal tool isn’t intended to replace Photoshop or other pixel editors, but it 
allows you to quickly remove dust spots and other small distractions.

Select the second icon in the Tool Strip, beneath the Histogram, or press the Q key. 

Adjust the brush size using the slider in the Options panel and then click on the spot in the photo, 
or click and drag to remove a line or non-circular shape. Lightroom will automatically try to find a 
good source, but you can then click and drag the circles to fine tune the correction. 

If you want to delete a spot correction, hold down the Alt key (Windows) / Opt key (Mac) to change 
the cursor into a pair of scissors, and then click on the spot again.

 Figure 91  Lightroom will find some new pixels to cover 
the distraction, but you can click and drag that overlay to 
choose a different source.

 Figure 90  Click and drag to paint over the distraction. Figure 89  Find a spot or distraction in the photo, such 
as this piece of seaweed on the sand.

 Figure 88  Select the Spot Removal tool from the Tool 
Strip under the histogram.
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MAKING LOCAL ADJUSTMENTS
Most of Lightroom’s controls apply to the whole photo, but the Local Adjustments allow you to apply 
settings to specific areas, either using a gradient or a brush.

The Linear Graduated Filter is useful for things like darkening the sky in a sunset photo. Select the 
Linear Graduated Filter in the Tool Strip, just below the Histogram. In the Options section below, 
you select the settings that you want to apply selectively. It can help to select settings that will be 
obvious, for example, Exposure -1, as you can go back and change them later. Click on the photo 
and drag to create your gradient, for example, drag from the top down to darken the sky. Lines will 
appear on screen, showing the limits of the gradient. The outer lines show where the gradient starts 
and stops, and you can drag those lines to increase or decrease the range. The center line allows 
you to rotate the gradient. Once you’re happy with the gradient, you can adjust the local Develop 
settings in the Options panel.

The same principle applies for the Radial Graduated Filter, except that creates a circular or oval gradient.

The Adjustment Brush allows you to paint on the photo, perhaps to lighten dark shadows or apply a 
different white balance to a specific area of the photo. Select the Adjustment Brush in the Tool Strip 
and select your chosen settings in the Options section below. As with the Graduated and Radial 
Filters, you can go back and fine tune those settings later. Click and drag on the photo to paint your 
brush strokes. If you make a mistake, hold down the Alt key (Windows) / Opt key (Mac) to turn the 
brush into an eraser, and click and drag over the mistake to remove the brush stroke.

The local adjustments will be marked with pins, which are small white circles. When a pin is selected, 
it will have a black center, showing that you can edit the settings or delete the whole adjustment.

 Figure 92  The Graduated Filter, Radial Filter and 
Adjustment Brush are the 4th, 5th and 6th tools in the Tool 
Strip under the histogram.
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The Adjustment Brush allows you to paint on the photo, perhaps to lighten dark shadows or apply a 
different white balance to a specific area of the photo. Select the Adjustment Brush in the Tool Strip 
and select your chosen settings in the Options section below. As with the Graduated and Radial Filters, 
you can go back and fine tune those settings later. Click and drag on the photo to paint your brush 
strokes. If you make a mistake, hold down the Alt key (Windows) / Opt key (Mac) to turn the brush 
into an eraser, and click and drag over the mistake to remove the brush stroke.

The local adjustments will be marked with pins, which are small white circles. When a pin is selected, 
it will have a black center, showing that you can edit the settings or delete the whole adjustment.

 Figure 93  The Graduated Filter is ideal for darkening 
skies. The central line rotates and the outer lines show 
the limits of the gradient.

 Figure 94  The side of the lion’s face is in shadow, so we 
can use the Adjustment Brush to selectively lighten that 
area. The red Mask Overlay shows the brush strokes, and 
can be turned on and off using the O key or the checkbox 
in the Toolbar.

SHORTCUTS

Q =   Spot Removal 
M =   Graduated Filter 
Shift-M =  Radial Filter 
K =   Adjustment Brush 
Delete =  Delete selected local 
  adjustment or spot

http://www.lightroomqueen.com/lr5quickstart


ADOBE PHOTOSHOP LIGHTROOM 5 - QUICK START GUIDE

www.lightroomqueen.com/lr5quickstart 67

Lightroom is a brilliant workflow tool, but there are still some tasks, such as 
detailed retouching or merging panoramas, that require a pixel editor such as 
Photoshop. Lightroom can pass your edited photo over to your pixel editor and add 

the result back into the catalog.

INTEGRATION WITH PHOTOSHOP
If a full version of Photoshop is installed on your computer, it should appear in Photo menu > Edit 
In or the right-click menu. You can also press Ctrl-E (Windows) / Cmd-E (Mac) to open the photo 
into Photoshop.

If the photo is a raw file and you’re using ACR 8 in CS6 or CC, Lightroom should open the photo 
directly into Photoshop. Older versions will ask how to handle an ACR mismatch, so press Render 
Using Lightroom in order to ensure the file renders correctly.

If you’re working with a JPEG, TIFF, PSD or PNG file, a dialog will appear asking how to handle 
the file. Select Edit a Copy with Lightroom Adjustments to open your photo with your Develop 
adjustments applied.

Once you’ve finished editing the photo in Photoshop, press Save and then close the photo and 
switch back to Lightroom. Your edited photo will be updated in your catalog.

FURTHER EDITING IN OTHER PROGRAMS

 Figure 95  Lightroom can pass your photos to 
Photoshop and other external pixel editors.
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INTEGRATION WITH PHOTOSHOP 
ELEMENTS
Not everyone needs the power of full 
Photoshop. Elements can do many of the 
tasks photographers require. Like Photoshop, 
Lightroom recognizes when a recent version 
of Elements is installed, and Photo menu > 
Edit In > Edit in Photoshop Elements or Ctrl-E 
(Windows) / Cmd-E (Mac) will open the photo 
into Photoshop Elements. Once you’ve finished 
editing the photo, save and close before 
returning to Lightroom.

 Figure 96  You can set up multiple additional external editors using the External Editing tab in 
the Preferences dialog.

Not everyone needs 
the power of full 
Photoshop. Elements 
can do many of the 
tasks photographers 
require.” 
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 Figure 97  If you open a JPEG, TIFF, PSD or PNG file 
into Photoshop, or any file format into other non-Adobe 
editors, you’ll see a dialog like this one, asking how you’d 
like to handle the file.

OPENING PHOTOS IN OTHER EDITORS
Lightroom can also send files to other external editors, such as OnOne software, Nik software, 
Pixelmator or PaintShop Pro.

Some of those editors come with their own Lightroom plug-ins and presets which are installed 
automatically. If your editor doesn’t install its own connection, you can set it up manually.
Go to Lightroom’s Preferences dialog, under the Edit menu (Windows) / Lightroom menu (Mac) 
and select the External Editors tab. In the bottom half of the dialog, press Choose and navigate 
to the program’s exe file (Windows) / app (Mac). Select other preferences below—TIFF is a good 
choice for file format, and 8-bit vs. 16-bit will depend on your specific editor. If the software is 
color managed, such as the editors mentioned above, select ProPhoto RGB as the color space. 

Finally, in the Preset pop-up, select Save Settings as New Preset and give your editor a name. It 
will then be accessible from the Photo menu > Edit In and right-click menus.
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Having done all this work, you’ll want people to see your photos, whether that’s 
on your screen, on their own computers, or even as prints, so let’s explore 
Lightroom’s most frequently used output options.

Lightroom is non-destructive, which means that it doesn’t save over your original image data. To 
apply your settings to the photo, you use Export, which is like a Save As in other programs.

When you export photos, it’s usually for a specific purpose, such as posting on the web, giving 
them to someone else, or sending them away to be printed. Most exports can be deleted after 
use, as the photos can be exported again in future, using the settings saved in the catalog.

‘SAVE AS’ A COPY ON THE HARD DRIVE
To export your photos, select them and then go to File menu > Export or press the Export 
button at the bottom of the left panel group in Library module. These are the main settings 
you’ll need to check:

1. Destination—choose the Destination folder for the exported photos.

2. File name—you can rename on export, for example, creating a template for Sequence 
#(001)-Filename will put a sequence number before your existing filename to ensure that they 
sort correctly in other software.

3. File Format—JPEG is an excellent choice for web, email, etc. You’ll need to select a quality 

YOUR FINISHED PHOTOS

IMAGE SIZE & RESOLUTION

When digital photographers speak of 
image size, they’re usually referring to 
the pixel dimensions—the total number 
of pixels along a photo’s width and 
height. For example, an uncropped file 
from an 18 megapixel camera may be 
5184 x 3456 pixels.

Pixels don’t have a fixed size. They 
expand or contract to fill the space. If 
you expand them too much, the photo 
appears blurry and pixelated (you can 
see the squares), so the aim is to keep 
the pixels smaller than or equal to the 
monitor pixels or printer dots.

Resolution—for example, 300 pixels per 
inch—only comes into effect when you 
combine it with a physical size such as 
4” x 6”.
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setting. TIFF is best for pixel editors such as Photoshop. Original format is a duplicate of the 
original photo, with extra metadata, but without your Develop adjustments applied.

4. Color Space—select sRGB for screen/web use or ProPhoto RGB for color managed pixel editors 
such as Photoshop.

5. Size—refers to the pixel dimensions of the photo. There are some sample sizes in the sidebar.

6. Output Sharpening—select Screen for screen/web use, and the type of paper for prints.

Destination (1)

File Name (2)

File Format (3)

File Size (5)

Color Space (4)

Sharpening (6)

Figure 98  Use Export to create copies of your 
photos with your adjustments applied.

EXPORT SIZES

If you’re just starting out, here are 
some sample export settings for 
different uses:

Email—Longest Edge 800px, and you 
can ignore the resolution as we’re 
specifying the size in pixels. Format 
JPEG, quality 60-80.

4” x 6” digital print—Dimensions 4” x 6” 
at 300ppi. Format JPEG, quality 80-100.
8” x 10” digital print—Dimensions 8” 
x 10” at 300ppi. Format JPEG, quality 
80-100.

Full resolution master—uncheck the 
Resize to Fit checkbox. Format TIFF/
PSD or JPEG quality 100.
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EMAILING YOUR PHOTOS
Lightroom makes it easy to email your photos. Select the photos and then go to File menu > Email Photos.

If your default email client is supported, such as Outlook or Apple Mail, it will show the Email 
dialog. Select the photo size using the preset in the bottom left corner. If you leave the address 
and the rest of the email blank and press Send, it’ll open the email message into your email 
software so you can access your address book. Alternatively you can type your email into the 
Email dialog and send it directly.

If you use webmail or an unsupported email client, Lightroom will first ask you for your email 
account settings. Once your email account is set up, you can enter the recipient’s email address 
and your message into the Email dialog before pressing Send.

sRGB FOR WEB

Lightroom offers a choice of different 
color spaces when you output photos. 
Large color spaces (ProPhoto RGB and 
Adobe RGB) retain the most data, so 
they’re used when transferring photos 
to Photoshop, but they’ll look odd in 
programs that aren’t color managed, 
such as web browsers. Use sRGB for 
screen output, emailing or uploading 
to the web.

Figure 100  The Email dialog allows you to create an 
email with the photos automatically attached. Set the 
image size using the pop-up in the bottom left corner.

 Figure 99  If your default email client isn’t supported, 
Lightroom will ask for your server details.
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PRINTING YOUR PHOTOS
If you’re sending your photos to an online lab to be printed, turn back to the Export page and 
export JPEGs to send away, but if you’re printing to a locally attached printer, such as an inkjet 
printer, you can use Lightroom’s Print module to print your photos. Let’s create a simple 4”x6” print.

First, select the photo or photos you want to print, and then switch to the Print module using the 
Module Picker at the top of the screen.

At the bottom of the left panel group, press the Page Setup button and select your paper size 
before returning to Lightroom. If you’re using 4x6 borderless paper, you’ll need to select that 
borderless paper size.

In the Layout Style panel at the top of the right panel group, select Single Image/Contact Sheet, 
and then in Image Settings, check Zoom to Fill and Rotate to Fit.

Figure 101  Select your 
page layout settings in 
the right panel group in 
the Print module. These 
are settings for a 4”x6” 
borderless print.
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In the Layout panel, set all the margins to 0 for borderless printing. If they won’t go down to 0, 
either the Page Setup is not set to borderless or the printer doesn’t support borderless, in which 
case you’ll need a larger piece of paper.

Still in the Layout panel, set the Rows and Columns to 1 to put a single photo on the page, and 
set the Cell Size to 6x4 for a 6” x 4” print. If you prefer to work in centimeters, you can change 
the units using the pop-up at the top of the panel.

Finally, scroll down to the Print Job panel. As a default, set the Print Resolution to 360ppi for 
Epson or 300ppi for Canon/HP and enable the Print Sharpening.

If you have a profile for your printer, select Other from the Color Management Profile pop-up and 
choose the profile. If you don’t have a profile, select Managed by Printer so that the printer cares 
for the color management.

Finally, press the Printer button to view the Print dialog. Select your paper type, quality settings 
and any other settings specific to your printer driver, and then press Print.

Figure 102  After setting up the print layout in 
Lightroom, press the Printer button and select the correct 
paper and quality settings.

If you don’t have 
a profile, select 
Managed by 
Printer so that 
the printer cares 
for the color 
management.”
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Lightroom is a vast program, with lots to learn, so this is just the start of your 
journey. There’s a friendly community surrounding Lightroom, who are ready to 
help you learn.

You can find more information in the official Help Files at http://helpx.adobe.com/lightroom.html
Adobe’s official beginners forums are at http://forums.adobe.com/community/lightroom/
lightroom_for_beginners and then you can graduate to their main Lightroom forums at 
http://forums.adobe.com/community/lightroom

If you prefer a smaller, friendlier, independent forum, come and join us at 
http://www.lightroomforums.net where you’ll be given a warm welcome.

Finally, books and videos are a great way to learn, without having to wait for people to answer 
your questions. There’s an excellent range of Lightroom training materials available, suited to 
different learning styles.

My own book, Adobe Photoshop Lightroom 5 - The Missing FAQ, is primarily designed as a FAQ-
style reference book, rather than step-by-step tutorials. It starts off with this Quick Start Guide as 
the first chapter, and then switches to a conversational question and answer format, so you can 
comfortably flip around the book, reading the sections that interest you most at the time.

CONGRATULATIONS, YOU’RE NOW A LIGHTROOM USER!

http://helpx.adobe.com/lightroom.html
http://forums.adobe.com/community/lightroom/lightroom_for_beginners
http://forums.adobe.com/community/lightroom/lightroom_for_beginners
http://forums.adobe.com/community/lightroom
http://www.lightroomforums.net
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It doesn’t tell you what you ‘must’ do, but helps you to understand the information you need to 
make good decisions about your own workflow, like the decisions you made in the Before You 
Start section of this guide. It’s full of real-world answers to real questions asked by real
Lightroom users.

It’s available from http://www.lightroomqueen.com in PDF, ePub, Kindle and paperback, and the 
paperback is also available from bookstores such as Amazon. I hope you enjoy it!

It doesn’t tell you what you ‘must’ do, but 
helps you to understand the information 
you need to make good decisions about 
your own workflow”

GET THE BOOK!

It’s available from 
http://www.lightroomqueen.com in 
PDF, ePub, Kindle and paperback, and 
the paperback is also available from 
bookstores such as Amazon. 

I’m sure you’ll find it useful!

http://www.lightroomqueen.com/lr5quickstart
http://www.lightroomqueen.com/
http://www.lightroomqueen.com/
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